Table of contents

1. Introduction ........................................................................................................... 4
2. Installation and options .......................................................................................... 8
   2.1. System requirements ....................................................................................... 8
   2.2. Installation ........................................................................................................ 8
   2.3. Continuing to use an existing user.mdb .......................................................... 9
3. Browser (Imagebrowser and Objectbrowser) .......................................................... 10
   3.1. Browser - overview ......................................................................................... 10
   3.2. Data tables of ImageBrowser .......................................................................... 10
   3.3. Thumbnail pictures in Imagebrowser ................................................................. 13
   3.4. Filter ................................................................................................................ 14
   3.5. Slide Show and ‘>>>’-Button ........................................................................... 16
   3.6. ObjectBrowser ................................................................................................ 16
4. Object names in the database .................................................................................. 18
   4.1. Catalogues in the object database .................................................................. 18
   4.2. Set Object function ......................................................................................... 19
   4.3. Alias names for catalogues ............................................................................. 20
   4.4. Set Object with wildcard search .................................................................... 20
5. Set Filter ................................................................................................................. 22
6. Planner ................................................................................................................... 24
   6.1. Overview .......................................................................................................... 24
   6.2. Create a new planner data row ...................................................................... 25
   6.3. Create new planner data rows with ObjectBrowser ....................................... 26
   6.4. Edit and Delete planner data rows .................................................................. 27
   6.5. Filter the planner data rows .......................................................................... 27
   6.6. Slide Show and ‘>>>’-Button ........................................................................... 28
   6.7. ListView ......................................................................................................... 28
   6.8. Export csv and Export OT ............................................................................. 28
7. Edit Setup ............................................................................................................... 30
   7.1. Cameras, telescopes and observers ............................................................... 30
   7.2. Setups ............................................................................................................... 31
8. Edit Object ............................................................................................................. 32
   8.1. Create new object ............................................................................................ 32
   8.2. Edit and delete an existing object .................................................................... 32
   8.3. Import Comets and Clear Comets .................................................................. 32
9. Edit Picture ............................................................................................................. 33
   9.1. Overview .......................................................................................................... 33
   9.2. Create a new picture with New button ........................................................... 33
   9.3. Create a new picture with Clone button .......................................................... 35
10. ObjectTracker ....................................................................................................... 37
1. INTRODUCTION

CCD-Guide is a project of Astronomischer Arbeitskreis Salzkammergut (AAS) – Gahberg observatory (www.astronomie.at). Since 1997 the CCD team of the observatory Gahberg publishes once a year a new DVD which contains the best CCD and DSLR images of the AAS members. The total revenue from the sale of the DVD is used to assist the association and delivers a small financial contribution to the current AAS projects.

You can find a summary of the new features of release 3.4 at the end of this document in chapter 13. CCD-Guide assists both, the beginner in astrophotography as well as the advanced astrophotographer with the following key features:

- **Image Browser:** You can easily browse through more than 5,000 images. At the same time you can see object data, image data and a thumbnail picture. A double click on the thumbnail picture opens the image in IrfanView, a professional and often used image viewer. The access to additional pictures (e.g. image with object identification, inverted image,..) is also provided.

- **Objectname Filter:** If you want to select all images, which show a particular object, simply enter the object name or an alias name of the object name. Proper names or even parts of object names often guide you to the searched images.

- **Quick Filter:** When you enter a search string into the edit field of the QuickFilter, then only those data rows are shown which contain this search string in one of the data fields.
- **Set Filter:** You can easily create a subset of images using many different criteria (e.g. coordinates, object type, object size, constellation, catalogue, observer, camera, telescope, date, …)

- **Slideshow:** After you have defined a particular subset of images using the set filter feature, you can start a slideshow to browse through all images in full screen mode.

- **No software installation necessary:** All above features are available, when you start CCD-Guide directly from the DVD. Even if you want to use the advanced features of CCD-Guide (input of your own images, planning tool) there is no installation necessary: Simply copy the CCD-Guide folder from the DVD onto your hard disk.

- **Object database:** CCD-Guide contains a big database of objects including object data. The database contains 30 different catalogues of deep sky objects, which are based on the revised NGCIC catalogue of Wolfgang Steinicke, the nebula database of Eric-Sven Vesting and the NED and Vizier databases. A big advantage of CCD-Guide is that there exists only one data row for one object. Each physical object has a master object name, but you can find this object also with the alias names (entries in other catalogues).

- **Input your own objects:** In case that some special objects are missing (e.g. comets), you can input your own objects including object data.
- **Input your own images**: You can input your own images including additional pictures and additional objects.

- **Planner**: First, you can create different setups (telescope + camera combination). Then you can use the object database to create your planning list for each setup. A very useful feature of the Planner is the possibility to assign a reference image and a field-of-view image to each planning data set.

- **ObjectTracker**: ObjectTracker answers quickly and easily the question whether a certain object can be photographed at a selected location in a certain night. The ideal time window for observing is calculated taking into account twilight, moon, object altitude and optional horizon. The altitude progression of the object and of the moon is displayed in an intuitive graphic.
2. INSTALLATION AND OPTIONS

2.1. System requirements

The core of CCD-Guide (the CCD-Guide.exe) runs on all common Windows platforms, starting with Windows XP up to Windows 10. In order to be able to use the ObjectTracker functionality, the following requirements are necessary:

- Operating system: Windows 7 or higher
- CLR (Common Library Runtime) .net 4.5.2 or higher

It is recommended to use CCD-Guide on a computer with the operating system Windows 7 or higher. All updates of the operating system should have been performed.

2.2. Installation

The easiest way to use CCD-Guide is starting the software from DVD. An installation on hard disk is only necessary, if you want to use the advanced features (input of your own images, planning tool and ObjectTracker) or if you want to see also our archive images. A further advantage of an installation on hard disk is of course a better speed.

The installation procedure is very easy: Simply copy the content of the folder 010_ccd_guide from the DVD to a new folder on your hard disk (e.g. to c:\ccdguide\ or to d:\ccdguide\).

Please, do not copy the folder into the Windows system folders like c:\Program Files\, c:\Program Files (x86) or c:\Windows!

Then start CCD_Guide.exe via double click. The next step is to move to the Options tab.

Please, check and modify the following paths:
CCD-Guide 3.4 Manual

- Database path: This folder contains the master database (Details can be found in chapter 11.) There is no need to change this path.
- Master image path: This folder contains all master images. There is no need to change this path.
- User data path: This folder contains all user data including the user database, the archive of user images and the planner images of the user.
- Planetarium Path: If you have one of the following planetarium software (Cartes du Ciel; Guide 8 Update; Guide 9; The Sky6 Pro or The SkyX Pro) installed on your computer, then you can set this path to have a fast access to your preferred planetarium software inside CCD-Guide. If you want to use The Sky, then it is necessary to start The Sky as administrator at one time before using the planetarium button in CCD-Guide.

You can set three other program options:
- Archive Images: You can decide which images are visible in the Imagebrowser. Archive images are older images, which can be excluded.
- Show Pictures in Imagebrowser: You can decide which images are visible in Imagebrowser: only master images, only your own images or all images.
- Show Tooltips: Tooltips can be activated or deactivated.

It is necessary to click Save to set any changes in the Options tab.

2.3. Continuing to use an existing user.mdb
If you are already a CCD-Guide user and if you want to continue using your existing data in the old user.mdb, then proceed as follows, depending on the existing old CCD-Guide release:

**Release 3.3 or newer:**
- Copy the folder 010_ccd_guide from the DVD to a new folder on the hard disk.
- Copy the existing "userdata" directory from the old CCD Guide installation directory to the new CCD Guide installation directory (overwriting the existing user.mdb).
- Update the paths in the Options tab as described above.

**Release 3.2 or older:**
- Copy the folder 010_ccd_guide from the DVD into a new folder on your hard disk.
- Copy your existing user.mdb from the subfolder “database” of the old CCD-Guide installation into the subfolder „userdata“ of the new CCD-Guide installation (Overwrite the existing user.mdb).
- Copy your folder with the user images (user_images) and the folder with the planner images (planner_images) from the old CCD-Guide installation into the subfolder “userdata” of the new CCD-Guide installation.
- Update the paths in Options tab.
3. **BROWSER (IMAGEBROWSER AND OBJECTBROWSER)**

3.1. **Browser - overview**

The Browser is the most important tab. At the same time you can see object data, image data and a thumbnail picture. A double click on the thumbnail picture opens the image in IrfanView, a professional and often used image viewer.

You can use the arrow keys of your keyboard or you can simply click on a data row in the bottom table of the Browser tab to change the active data row. The active data row is bluely coloured. The thumbnail picture is always connected with the active data row. Also the contents of the other tables (AdditionalObjects, ObjectAlias, Observer and ObjectRelation) near the right top corner in the Browser tab are always connected with the blue active data row.

The Browser can be used in two different modes:

1. **ImageBrowser**: is the default mode. You can browse through all images of the CCD-Guide database.
2. **ObjectBrowser**: gives you the possibility to browse through the object data of all objects of the CCD-Guide database. This mode is very useful for planning.

3.2. **Data tables of ImageBrowser**

The ListView button (to the right above the main data table) gives you the possibility to change the appearance of the main data table:

- **Simple**: Only the most important data columns are visible.
- **Image**: Image related data columns are visible.
- **Object**: Object related data columns are visible.
- **Full**: All data columns are visible.
- **User**: User defined data columns are visible.
You can modify the user defined data columns (include or remove data fields) by clicking on option “Select User Columns”.

For each of the five different list views (Simple, Image, Object, Full and User) you can modify the order of the columns by drag and drop, you can change the width of each column and you can save these settings by clicking on the Save Listview option. With the Reset Listview option you can reset the settings to the original settings.
The following table describes each data field of the main data table.

<table>
<thead>
<tr>
<th>Data field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PICTURENAME</td>
<td>Name of the picture in folder 'images'</td>
</tr>
<tr>
<td>OBJECTNAME</td>
<td>Name of the main object, which is visible in the image</td>
</tr>
<tr>
<td>OBJECTTYPE</td>
<td>Object type (e.g. Galaxy, Emission Nebula,...)</td>
</tr>
<tr>
<td>OBJCLASS</td>
<td>Classification of the object (e.g. Hubble class of a galaxy; Trumpler class of an open star cluster,...)</td>
</tr>
<tr>
<td>RA2000</td>
<td>Right ascension [h]</td>
</tr>
<tr>
<td>RATXT</td>
<td>Right ascension [hh mm ss.s]</td>
</tr>
<tr>
<td>DE2000</td>
<td>Declination [°]</td>
</tr>
<tr>
<td>DETXT</td>
<td>Declination [±dd mm ss]</td>
</tr>
<tr>
<td>CONSTELLATION</td>
<td>Name of constellation (e.g. Andromeda)</td>
</tr>
<tr>
<td>OBJSIZE</td>
<td>Object size [arcmin]</td>
</tr>
<tr>
<td>MAG</td>
<td>Magnitude [mag]</td>
</tr>
<tr>
<td>SB</td>
<td>Surface brightness [mag/arcmin²]</td>
</tr>
<tr>
<td>NB</td>
<td>Nebula brightness [1 = very bright; 6 = very faint]</td>
</tr>
<tr>
<td>PICSEQNR</td>
<td>Picture sequence number (highest picture number in data base)</td>
</tr>
<tr>
<td>OBJECTCOMMENT</td>
<td>Comments concerning the object (e.g. discovered in year 1960)</td>
</tr>
<tr>
<td>EXPTIME</td>
<td>Exposure time [free description]</td>
</tr>
<tr>
<td>EXPTIMETOTAL</td>
<td>Total exposure time [min]</td>
</tr>
<tr>
<td>CAMERA</td>
<td>Product name of the camera</td>
</tr>
<tr>
<td>RESMODE</td>
<td>Resolution mode (e.g. Binning)</td>
</tr>
<tr>
<td>OBSYEAR</td>
<td>Year of observation date</td>
</tr>
<tr>
<td>OBSMONTH</td>
<td>Month of observation date</td>
</tr>
<tr>
<td>OBSDAY</td>
<td>Day of observation date</td>
</tr>
<tr>
<td>OBSDATADD</td>
<td>Additional observation date</td>
</tr>
<tr>
<td>TELESCOPE</td>
<td>Product name of the optics (telescope or photo lens)</td>
</tr>
<tr>
<td>APERTURE</td>
<td>Aperture [inch]</td>
</tr>
<tr>
<td>FOCALLENGTH</td>
<td>Focal length [mm]</td>
</tr>
<tr>
<td>SETUPINFO</td>
<td>Further information concerning setup (telescope + camera + mount)</td>
</tr>
<tr>
<td>LOCATION</td>
<td>Location of image acquisition</td>
</tr>
<tr>
<td>LEVELOVERSEA</td>
<td>Level over sea of location [m]</td>
</tr>
<tr>
<td>FILTER</td>
<td>Used filters (e.g. Ha, OIII,...)</td>
</tr>
<tr>
<td>MOUNT</td>
<td>Product name of the mount</td>
</tr>
<tr>
<td>PICTURECOMMENT</td>
<td>Further comments (e.g. weather conditions)</td>
</tr>
</tbody>
</table>
With a simple click on the header of a data field (e.g. TELESCOPE) you can sort the data rows in alphabetical order (ascending and descending).

The four tables near the right top corner deliver additional information:

- **ADDITIONALOBJECTS**: This is a list of additional objects, which are also visible in the active picture. (e.g. In the following example the main object is M 81 and the two additional objects M 82 and UGC 5336 are also visible in the image).

- **OBJECTALIAS**: This is a list of all object alias names of the main object (= M 81 in our example), which can be found in the database of CCD-Guide.

- **OBSERVER**: This is a list of all observers.

- **OBJECTRELATION**: Objects in relation to the main object are listed.

### 3.3. Thumbnail pictures in Imagebrowser

When you scroll through the data rows of the main table, then you will notice that some data rows are connected with two thumbnail pictures: a main picture and to the right of the main picture a smaller additional picture. A double click on a thumbnail picture always opens the image in IrfanView. The additional pictures deliver some additional information about the main picture: e.g. object identification, inverted image, …

If more than one additional image exists, then you can find arrow buttons below the thumbnail picture of the additional picture. With these arrow buttons you can move through all additional pictures. The following example shows an image of the galaxy cluster Abell 2218. Two additional pictures are connected with the main picture.
3.4. Filter

CCD-Guide offers three different possibilities to filter a main data table (reduce number of visible datasets):

- Objectname Filter
- Quick Filter
- Set Filter

The Objectname Filter is a very useful feature, if you are interested in all images, which show a particular object. First choose the Objectname Filter, then enter the object name (e.g. M 82) in the white edit field to the right and press the return button on your keyboard.

Now the text “M 82” is shown in bold letters, which indicates that the Objectname Filter is active. The main data table contains only those images in which the desired object (e.g. M 82) is visible. The bottom example shows 20 data rows in the main data table. You can see also pictures in the data table with OBJECTNAME = M 81. Those pictures contain both objects: M 81 and M 82!
With the Reset Filter button you can reset the filter and all pictures are visible in the main data table. If you want to learn more about the nomenclature of objects in the database of CCD-Guide and if you want to use the powerful wildcard search then please have a look at chapter 4.

The Quick Filter is a very fast and efficient way to reduce the number of data rows in a main data table. When you enter a search string into the edit field of the QuickFilter, then only those data rows are shown which contain this search string in one of the data fields. In the following example all data rows are shown which contain the text “Namibia” in one of the data fields. 326 data rows are shown. The search text is shown in bold letters, which indicates that the Quick Filter is active.

You can use more than one search text by using the comma separator “,”. The following example searches all data rows which contain the text “Namibia” or the text “Chile”. 516 data rows are shown.

The Set Filter button opens the Set Filter window, a very powerful tool to filter your data rows using many different criteria (e.g. coordinates, object type, object size, constellation, catalogue, observer, camera, telescope, date). Bold characters of the Set Filter button indicate an activated filter. Set Filter is explained in detail in chapter 5.
3.5. Slide Show and ‘>>>’-Button

The Slide Show button creates a slide show of all visible pictures in the main data table. So, if you have filtered for images of M 82, then a click on the Slide Show button opens IrfanView in slide show mode and now you can have a look at all images of M82 in full screen mode.

The button “>>>” contains functions which are related to the active (blue coloured) data set:

- **Planetarium**: The Planetarium button opens your preferred planetarium software centred on the active object. Use tab Options to define your preferred planetarium software (chapter 2).
- **Sky-map.org**: When you are connected to the internet then you can use the Sky-map.org button to open sky-map.org centred on the active object.
- **ObjectTracker**: The ObjectTracker button starts ObjectTracker with the active object. ObjectTracker answers the question whether and when the selected object can be photographed well. Details on how to use ObjectTracker can be found in chapter 10.
- **Export to Planner**: Use the Export to Planner button to export the active object to the Planner tab. The Planner tab is described in detail in chapter 6.

3.6. ObjectBrowser

If you are already familiar with the ImageBrowser, then the usage of the ObjectBrowser is very easy. The only difference is that now all objects of the database are listed in the main data table regardless of whether images of these objects exist or not exist. If an excellent image of an object is available in the CCD-Guide database, then this image is shown in the thumbnail picture. The ObjectBrowser shows always only one image of an object even if more images of this object exist. The text “Excellent image missing” is shown in the thumbnail picture, when no excellent image of this object exists.
Excellent image missing
4. OBJECT NAMES IN THE DATABASE

4.1. Catalogues in the object database

CCD-Guide contains a big database of objects including object data. The database contains 30 different catalogues of deep sky objects, which are based on the revised NGCIC catalogue of Wolfgang Steinicke, the nebula database of Eric-Sven Vesting and the NED and Vizier databases. A big advantage of CCD-Guide is that there exists only one data row for one object. Each physical object has a master object name, but you can find this object also with the alias names (entries in other catalogues).

The following table summarizes the standard catalogues of deep sky objects. You can find one example for an object name in the last column (The catalogue name is always followed by a blank character).

<table>
<thead>
<tr>
<th>Catalogue</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABELL</td>
<td>Rich Clusters of Galaxies</td>
<td>ABELL 426</td>
</tr>
<tr>
<td>ARP</td>
<td>Arp’s Peculiar Galaxies</td>
<td>ARP 268</td>
</tr>
<tr>
<td>BARNARD</td>
<td>Barnard's Dark Nebulae</td>
<td>BARNARD 72</td>
</tr>
<tr>
<td>CED</td>
<td>Cederblad Catalogue of Bright Diffuse Galactic Nebulae</td>
<td>CED 106n</td>
</tr>
<tr>
<td>CG</td>
<td>Cometary Globules</td>
<td>CG 4</td>
</tr>
<tr>
<td>CONST</td>
<td>Constellation</td>
<td>CONST And</td>
</tr>
<tr>
<td>DCLD</td>
<td>Catalogue of Southern Dark Clouds (Hartley+ 1986)</td>
<td>DCLD 247.5-12.3</td>
</tr>
<tr>
<td>DG</td>
<td>Dorschner+Gurtler Reflection Nebulae</td>
<td>DG 21</td>
</tr>
<tr>
<td>DWB</td>
<td>Dickel, Wendker and Bieritz HII Regions</td>
<td>DWB 111</td>
</tr>
<tr>
<td>GN</td>
<td>Atlas of Galactic Nebulae</td>
<td>GN 07.12.8</td>
</tr>
<tr>
<td>GUM</td>
<td>Gum’s catalogue of southern H-Alpha nebulae</td>
<td>GUM 12</td>
</tr>
<tr>
<td>HCG</td>
<td>Hickson Compact Groups of Galaxies</td>
<td>HCG 45</td>
</tr>
<tr>
<td>HH</td>
<td>Herbig-Haro Catalogue</td>
<td>HH 46</td>
</tr>
<tr>
<td>IC</td>
<td>Index Catalogue</td>
<td>IC 430</td>
</tr>
<tr>
<td>LBN</td>
<td>Lynd’s Catalogue of Bright Nebulae</td>
<td>LBN 999</td>
</tr>
<tr>
<td>LDN</td>
<td>Lynd’s Dark Nebulae</td>
<td>LDN 123</td>
</tr>
<tr>
<td>M</td>
<td>Messier</td>
<td>M 17</td>
</tr>
<tr>
<td>NGC</td>
<td>New General Catalogue</td>
<td>NGC 78A</td>
</tr>
<tr>
<td>PGC</td>
<td>Principal Galaxies Catalogue (LEDA)</td>
<td>PGC 10001</td>
</tr>
<tr>
<td>PK</td>
<td>Perek and Kohoutek’s Planetary Nebulae</td>
<td>PK 130-10.1</td>
</tr>
<tr>
<td>RCW</td>
<td>Rodgers, Campbell and Whiteoak southern HII regions</td>
<td>RCW 102</td>
</tr>
<tr>
<td>RNO</td>
<td>Red and Nebulous Objects in Dark Clouds (Cohen)</td>
<td>RNO 40</td>
</tr>
<tr>
<td>SANDQVIST</td>
<td>Sandqvist + Sandqvist-Lindroos Southern Dark Clouds</td>
<td>SANDQVIST 161</td>
</tr>
<tr>
<td>SH2-</td>
<td>Sharpless Catalogue of HII Regions</td>
<td>SH2- 87</td>
</tr>
<tr>
<td>UGC</td>
<td>Uppsala General Catalogue of Galaxies</td>
<td>UGC 6514</td>
</tr>
<tr>
<td>VDB</td>
<td>Van den Bergh’s Reflection Nebulae</td>
<td>VDB 23</td>
</tr>
<tr>
<td>VDBH</td>
<td>Van den Bergh + Herbst Reflection Nebulae</td>
<td>VDBH 80</td>
</tr>
</tbody>
</table>

The following table summarizes special catalogues of deep sky objects.

<table>
<thead>
<tr>
<th>Catalogue</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>GCL</td>
<td>Globular Star Clusters - Collection of Catalogues</td>
<td>GCL Terzan 9</td>
</tr>
<tr>
<td>OCL</td>
<td>Open Star Clusters - Collection of Catalogues</td>
<td>OCL Stock 23</td>
</tr>
<tr>
<td>PN</td>
<td>Planetary Nebulae - Collection of Catalogues</td>
<td>PN Abell 4</td>
</tr>
<tr>
<td>NAME</td>
<td>Common or historical name</td>
<td>NAME Barnard’s Galaxy</td>
</tr>
<tr>
<td>UNLISTED</td>
<td>UNLISTED objects are not included in the standard catalogues of CCD-Guide</td>
<td>UNLISTED LMC</td>
</tr>
</tbody>
</table>
The catalogues GCL, OCL and PN are collections of catalogues. GCL is based on the ‘Catalog of parameters for Milky Way globular clusters’ by William E. Harris and contains for example the globular clusters of the Palomar and Terzan catalogues. OCL is based on ‘Optically visible open clusters and Candidates’ by Dias+ and contains for example the open star clusters of the Stock, Berkeley and Trumpler catalogues. PN is based on the ‘Strasbourg-ESO Catalogue of Galactic Planetary Nebulae’ by Acker+ and contains for example the planetary nebulae of the Abell catalogue.

The NAME catalogue is a collection of common or historical names of deep sky objects. The UNLISTED catalogue is a possibility to enter further objects which are not included in the standard catalogues of the CCD-Guide database.

The following table summarizes catalogues of solar system objects.

<table>
<thead>
<tr>
<th>Catalogue</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMET</td>
<td>Comets</td>
<td>COMET C/2009 P1</td>
</tr>
<tr>
<td>SOLAR</td>
<td>Solar system objects except comets</td>
<td>SOLAR Jupiter</td>
</tr>
</tbody>
</table>

4.2. Set Object function

The Set Object function is used to find and to select a particular object by its name. This function is used by the Objectname Filter in the tabs Browser, Planner, Edit Object and Edit Picture. If you know a correct name of the object in the CCD-Guide database (e.g. VDB 33), then simply input this name in the Objectname text field and finish your input by pressing return on the keyboard.

A new window appears which shows you all possible objects in the database. In our example only one object was found: VDB 33 is an alias name for the object NGC 1788, a reflection nebula in the constellation Orion. Select this object and click OK.
4.3. Alias names for catalogues

You can search for an object using the ‘official’ catalogue name or using an alternate name for the catalogue. E.g: The ‘official’ catalogue name in the CCD-Guide database for Barnard’s Dark Nebulae Catalogue is ‘BARNARD’. So the object with number 99 in Barnard’s Catalogue is named ‘BARNARD 99’. The catalogue name ‘B’ is an alternative catalogue name for ‘BARNARD’ in the CCD-Guide database. So, you can use the short form ‘B 99’ instead of ‘BARNARD 99’ to find this object.

The following table lists all alias names for catalogues in the first column (Name) and the official catalogue name in the second column (CatType).

<table>
<thead>
<tr>
<th>Name</th>
<th>CatType</th>
</tr>
</thead>
<tbody>
<tr>
<td>MESSIER</td>
<td>M</td>
</tr>
<tr>
<td>ACO</td>
<td>ABELL</td>
</tr>
<tr>
<td>N</td>
<td>NGC</td>
</tr>
<tr>
<td>I</td>
<td>IC</td>
</tr>
<tr>
<td>APG</td>
<td>ARP</td>
</tr>
<tr>
<td>HICKSON</td>
<td>HCG</td>
</tr>
<tr>
<td>SHARPLESS</td>
<td>SH2-</td>
</tr>
<tr>
<td>S</td>
<td>SH2-</td>
</tr>
<tr>
<td>CEDERBLAD</td>
<td>CED</td>
</tr>
<tr>
<td>COHEN</td>
<td>RNO</td>
</tr>
<tr>
<td>B</td>
<td>BARNARD</td>
</tr>
<tr>
<td>LEDA</td>
<td>PGC</td>
</tr>
</tbody>
</table>

Examples:

Input the short form ‘N 78’ for the object name to find ‘NGC 78’.
‘S 101’ is an alternative to the official name ‘SH2- 101’.
‘B 99’ = ‘BARNARD 99’.

4.4. Set Object with wildcard search

The wildcard search is very powerful and helps you to find an object, when you do not know a correct name of the object in the database of CCD-Guide. If you include one or more * characters in the Find Object text field, then the * character is interpreted as a wildcard character. CCD-Guide substitutes this * wildcard character by any subset of possible characters, when you enter RETURN.

Below you can find some examples for the usage of the wildcard search.

Object search with common names:

Only a common name of the object is known (e.g. Perseus galaxy cluster, Horse head nebula, Comet Holmes, Holmberg IX). The best way is to put an important part of the common name between two * characters. E.g. input *perseus* in the Objectname text field and enter return.
A new window appears which shows you all objects which contain the string ‘perseus’ in their object name or in their alias object names.

Three objects are listed:

- OCL Melotte 20 = open star cluster Alpha Perseus
- NGC 1275 = galaxy Perseus A
- ABELL 426 = Perseus galaxy cluster

So, the third entry in the list is our searched object. Click on the data row of ABELL 426 and then push the OK button to select ABELL 426.

To find the Horse head nebula input *horse* and you will get two objects:

- BARNARD 33 = Horsehead Nebula
- M 17 = Horsehoe

To find Comet Holmes input *holmes* and you will get the searched comet 17P (Holmes).

To find Holmberg IX input *holmberg* and you will get a list of the nine Holmberg galaxies.

**Object search with unknown catalogue name:**

You know the object name, but you are not sure about the catalogue name in CCD-Guide (e.g. you are searching for the open star cluster Stock 23 or the planetary nebula Abell 4).

To find Stock 23 input *stock 23 in the Objectname text field and enter return. You will get one object (OCL Stock 23).

To find the planetary nebula Abell 4 input *abell 4 and you will get two possible objects:

- ABELL 4 = galaxy cluster
- PN Abell 4 = our searched planetary nebula
5. **SET FILTER**

The Set Filter window can be opened by clicking on the Set Filter button in the following tabs: Browser, Planner, Edit Object and Edit Picture.

The Set Filter window opens the possibility to set one or more filters on the main data table. The filter criteria are divided in three groups: Object related criteria (top left), picture related criteria (bottom left) and planner related criteria (top right). All filters are combined with a logical AND.

The following screenshot shows the Set Filter window opened inside the ImageBrowser. You can see that the planner criteria are greyed out, because these criteria are not used for the ImageBrowser. When you open Set Filter inside the ObjectBrowser, then only the object criteria are relevant and so the picture criteria and the planner criteria are greyed out. When you open Set Filter inside the Planner tab, then the object criteria and the planner criteria are important and the picture criteria are greyed out.

After you have input your desired filter criteria, you activate the filters by pushing the Set Filter button. To reset all filter criteria click Reset Criteria.

You can use the buttons Save Filter and Load Filter to save and reload your filter settings. This is very useful, if you create many complex and powerful filters.
The following screenshot shows an example for object criteria. Those pictures are visible whose main object fulfills the following criteria:

- Object type is globular star cluster or open star cluster.
- Declination is larger than 20°.
- Object size is larger than 20 arcmin and smaller than 40 arcmin.

The following screenshot shows an example for picture criteria. Those pictures are visible which fulfill the following criteria:

- Captured with a Newtonian telescope and with a SBIG ST-2000XM camera.
- The image is captured after 2011-01-01.
6. PLANNER

6.1. Overview

The Planner tab of CCD-Guide helps you to maintain your todo list of objects. It can help you to answer the question: Which object should I capture tonight? All entries are saved in the user database (user.mdb).

The concept of the planner is based on the idea that you want to capture a particular object with a certain setup of your equipment. In CCD-Guide a setup is a combination of a telescope and a camera using a particular focal length. So, before you can use the planner you have to create your personal setups in the Edit Setup tab (for details see Chapter 7).

The Planner tab is divided in three sections:

1. Edit frame (top frame): The edit frame gives you the possibility to edit all data fields including the two optional planner images (FOV Image and Ref Image) of a particular planner data row. To the right of the edit frame the two optional planner images of a planner data row are shown. A double click into the thumbnail image opens the image in IrfanView. The FOV Image shows the field of view and the Ref Image can be used to save a reference image.

2. Filter and info button line: Below the edit frame you find to the left all buttons for searching and filtering the planner data rows (Objectname Filter, Quick Filter and Set Filter) and to the right the Slide Show button and the info button “>>>”.

3. Planner data grid (bottom frame): The planner data grid shows all filtered planner data rows. The active planner data row is blue coloured and this data row can be edited in the edit frame.
6.2. Create a new planner data row

First, click New (to the right of the data table). Then all data fields in the edit frame are automatically cleared and you can start with your inputs. All blue coloured fields are must fields, white coloured fields are optional. First choose your desired setup in the dropdown box. After the selection of the setup you can see some details about your setup to the right of the setupname.

<table>
<thead>
<tr>
<th>Setupname</th>
<th>Chile RC23</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telescope</td>
<td>Ritchey-Chrétien</td>
</tr>
<tr>
<td>Camera</td>
<td>FLI PL16803</td>
</tr>
<tr>
<td>Focallength</td>
<td>4572mm / FOV = 27.7x27.7'</td>
</tr>
</tbody>
</table>

The next step is to set the object. To set an object, first enter the object name in the white field to the right of the Set Object button and then click Set Object or enter return. The Set Object function is described in detail in chapter 4.

<table>
<thead>
<tr>
<th>Objectname</th>
<th>ngc 3511</th>
</tr>
</thead>
</table>

The state field is the third must field which is necessary to define a planner data row. A planner data row can have seven different states:

- 0 - Image is missing
- 1 - Excellent image exists
- 2 - Good image exists
- 3 - Acceptable image exists
- 4 - Bad image exists
- 5 - Very bad image exists
- 6 - Image not finished

Setting a FOV Image (field of view image) or a Ref Image (reference image) is an optional step, but very useful step. When you push the FOV Image button, then the FOV Image window appears.
On the left side of this window you can find the FOV Image parameters, which are already filled with useful default values. If necessary, then you can modify the centre coordinates of the image, the field of view, the rotation angle of your camera, the height and the width of the FOV image and the server, which is used for downloading the DSS2 image from sky-map.org. When you push the Update button, then the download process is started. The Reset button resets all FOV image parameters to the default values. A red cross indicates the position of the new image centre. You can move the red cross by clicking the right mouse button or by pushing the arrow keys. After having moved the image centre you have to push the Update button to get the updated image. After pushing the Ok button the window is closed and the FOV Image is set. Please, activate the option “Add FOV Image parameters to Planner Comment”, if you like to have the centre coordinates inside the Planner Comment. After having closed the FOV Image window by pushing the Ok button, you can see your FOV image in the FOV Image tab. The red coloured text “Image not saved” indicates that you have to push the Save button to save this FOV image in your Planner Image Path.

If you have an image of the desired object of another astrophotographer, which you want to use as a reference, then you can include this image in the planner data row as a Ref Image. After pushing the Ref Image button a window for selecting the image appears. You can find the path of the selected image in the Image From field. Below the Image From field you can find the imagename field. The selected image is copied into the Planner Image Path and renamed, when you click Save. You can change the Planner Image Path in the Options tab.

The comment field is helpful for additional information (e.g. filters,..). With a double click into the Comment field you can open a window with a much bigger edit field.

When you are finished with your entries, then click Save to create the data row and to copy the optional FOV Image and the optional Ref Image into the Planner Image Path.

6.3. Create new planner data rows with ObjectBrowser

If you want to include many objects with particular criteria in your todo list, then you can use the Export to Planner button inside the ObjectBrowser. First switch to the Browser tab and select mode ObjectBrowser. Then filter the objects by using the Set Filter function. After you have reduced the number of objects to a manageable number, you can select an object and click the >>> Export to Planner button. The Export to Planner button opens the Planner tab and sets the desired object. When a picture was visible in the ObjectBrowser, then this picture is set as a Ref
image. The following example shows the state of the Planner tab after clicking the Export to Planner button inside the ObjectBrowser (object M 31 was selected in ObjectBrowser).

<table>
<thead>
<tr>
<th>Browser</th>
<th>Planner</th>
<th>Edit Setup</th>
<th>Edit Object</th>
<th>Edit Planner</th>
<th>Delete</th>
<th>Add</th>
<th>About</th>
</tr>
</thead>
</table>

After you have input the missing entries you click save to create the planner data row. Now, you can go back to the ObjectBrowser to export the next object into the Planner.

### 6.4. Edit and Delete planner data rows

If you want to edit a planner data row, then first activate the desired data row by clicking on the data row or by moving the cursor to the row using the arrow keys. The blue colour always indicates the selected data row. After you have modified the input fields in the edit frame, click the Save button to save the data row.

If you want to delete a planner data row, then first activate the desired data row. Then click on the Delete button to delete the selected planner data row. The optional planner images connected with the planner data row are also deleted.

### 6.5. Filter the planner data rows

If you have a big todo list of objects including many different setups, then it helps to reduce the list using filters. You can use the Objectname Filter, the Quick Filter or the Set Filter button in the same way as used in the Browser tab.

When you use the Objectname filter, then all data rows for the selected object are shown. The following screenshot shows the result of an object filter for ‘Abell 2151’.

<table>
<thead>
<tr>
<th>PlannerData</th>
<th>ABELL 2151</th>
<th>Set Filter</th>
<th>Reset Filter</th>
<th>Slide Show</th>
<th>&gt;&gt;&gt;</th>
<th>Lightview</th>
<th>Standard</th>
</tr>
</thead>
</table>

The Set Filter button opens the Set Filter window, where you can set object criteria and planner criteria. The following screenshot shows the planner criteria with two selected setups and a restriction of the state to ‘0 – Image is missing’. So, all planner data rows with missing images of setups 12”Newton+ST2000 and NP101+ST2000 are shown.
If the number of planner data rows is still too big, then you can set object criteria like coordinates or object type additionally to the planner criteria.

The Quick Filter can be very useful, when you use some keywords in the Planner comment field of important data rows. (E.g. “Prio1”).

If you click on the header of a data column, then you can sort the list ascending or descending. It makes sense to sort the list by right ascension.

The Reset Filter button deactivates all active filters.

6.6. Slide Show and ‘>>>’-Button

The Slide Show, Planetarium, sky-map.org and ObjectTracker buttons have the same function as in the Browser tab.

The Planetarium button opens your preferred planetarium software centred on the active object.

When you are connected to the internet then you can use the sky-map.org button to open sky-map.org centred on the active object.

The ObjectTracker button starts ObjectTracker with the active object.

6.7. ListView

The ListView button offers you to choose between two possible layouts of the main data table: Standard and User defined.

6.8. Export csv and Export OT

- You can export the main data table into a csv file by clicking on the button “Export”.
- The button "Export OT" exports the objects of the table to the ObjectTracker catalog file CCD_Guide.cat, which is located in the subdirectory \objecttracker\cat. How to use the file CCD_Guide.cat in ObjectTracker efficiently for planning is described in detail in chapter 10.
<table>
<thead>
<tr>
<th>DETXT</th>
<th>CONSTELLATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0s</td>
<td>Dorado</td>
</tr>
<tr>
<td>4.0s</td>
<td>Dorado</td>
</tr>
<tr>
<td>2.0s</td>
<td>Pavo</td>
</tr>
<tr>
<td>6.0s</td>
<td>Pegasus</td>
</tr>
<tr>
<td>6.0s</td>
<td>Pegasus</td>
</tr>
<tr>
<td>8.0s</td>
<td>Andromeda</td>
</tr>
<tr>
<td>8.0s</td>
<td>Pisces</td>
</tr>
<tr>
<td>6.0s</td>
<td>Pisces</td>
</tr>
<tr>
<td>6.0s</td>
<td>Cetus</td>
</tr>
<tr>
<td>8.0s</td>
<td>Andromeda</td>
</tr>
<tr>
<td>8.0s</td>
<td>Andromeda</td>
</tr>
<tr>
<td>0.0s</td>
<td>Aries</td>
</tr>
</tbody>
</table>
7. EDIT SETUP

The Edit Setup tab of CCD-Guide is necessary to create new cameras, new telescopes, new observers and new setups. All entries are saved in the user database (user.mdb).

7.1. Cameras, telescopes and observers

If one of your cameras is missing in the master database, then click New (the button to the right of the camera list). Input the name of the camera in the Key field. Please, use the official name of the manufacturer. The input fields Description, ChipSizeX and ChipSizeY are optional. Then click Save.

If one of your telescopes is missing in the master database, then click New (the button to the right of the telescope list). Input the name of the telescope in the Key field. Please, use the official name of the manufacturer. The input field Description is optional. Then click Save.

Use the same procedure to input a new observer. First, click New, then input all fields, and then click Save.

You are only allowed to edit your own data rows (SOURCE = USER) of the tables cameras, telescopes and observers. First, select your data row (indicated by the blue colour), then edit the input fields, and then click Save.

Tip: It makes sense to mark your own data rows (e.g. use the leading character '_' in your key fields. So, you can easily identify your cameras, telescopes and observers.
You can delete the active data row by clicking on the Delete button. **Be careful with deleting data rows! All pictures and planner data rows which are connected with the deleted data row are also deleted.**

7.2. **Setups**

Setups are needed for the planner. The concept of the planner is based on the idea that you want to capture a particular object with a certain setup of your equipment. In CCD-Guide a setup is a combination of a telescope and a camera using a particular focal length.

To create a new setup click on the New button (the button to the right of the setups list). Now you can enter a name for your setup. (Tip: Use a self-descriptive short name: e.g. 12" Newton-ST2000). Then choose the telescope and the camera in the drop down lists. The focal length is an optional input field. After you have input all data, you can save your setup by clicking on the Save button.

If you want to edit a particular setup, click on the desired setup in the setup data table. This data row will be blue coloured, which indicates that this data row is activated. Now, you can edit all input fields. Click the Save button to save your modifications.

If you want to delete a setup, then click the Delete button after you have activated the desired setup data row. **Be careful with deleting setups! The todo list of objects (planner data rows), which is connected with the deleted setup, is also deleted.**
8. EDIT OBJECT

8.1. Create new object

The Edit Object tab is the fourth tab of CCD-Guide. With this tab you can create new objects which are missing in the master database. These new objects are saved in the user.mdb.

First, click the New button. Then select the catalogue. You have three options:

- **COMET**: the new object is a comet. Please, enter the name using the nomenclature of the Minor Planet Center (e.g. C/2009 P1, 17P) and the Cometname (e.g. Garradd, Holmes). Then click Save.
- **SOLAR**: the new object is a minor planet. Please, enter the name of the minor planet (e.g. Vesta). Then click Save.
- **UNLISTED**: the new object is a deep sky object. Please, enter the name of the object and the object type. All other fields are optional. (Must fields are indicated by the blue colour. Optional fields are white. A detailed explanation for all optional fields can be found in chapter 3.2.) Then click Save.

8.2. Edit and delete an existing object

The data table of the Edit Object tab lists all objects of type COMET, SOLAR and UNLISTED which can be found in the master database and the user database. When you are working with the Edit Object tab, then you are automatically in the edit mode of an object data row. The blue colour indicates the active data row. You can change the active data row by clicking with the mouse or by pressing the arrow keys of your keyboard.

You will notice that you cannot edit or delete objects with SOURCE = MASTER. When you activate an object data row with SOURCE = USER, then you can edit the data fields. When you click Save then the modifications of the data fields are saved. When you click Delete, then this data row will be deleted.

8.3. Import Comets and Clear Comets

When you capture comets very often, then it makes sense not to enter new comets manually, but to import the new comets from the Minor Planet Center. You have to be connected with the internet to be able to use this function. Click on the Import Comets button to import all observable comets into your object database from www.minorplanetcenter.net.

The Clear Comets button removes all comets which are not used in the CCD-Guide database.
9. EDIT PICTURE

9.1. Overview

The Edit Picture tab of CCD-Guide is necessary to create new picture data rows. All entries are saved in the user database (user.mdb).

There are two possibilities to create a new picture:
- New button
- Clone button

9.2. Create a new picture with New button

First, click New (to the right of the data table). Then all data fields are automatically cleared and you can start with your inputs. All blue coloured fields are must fields, white coloured fields are optional. The best way is to start with the input of the object name. You can see that the Objectname data field (top left corner) is grey, which indicates that direct input is not possible. To set an object, first enter the object name in the white field to the right of the Set Object button and then click Set Object. The Set Object function is described in detail in chapter 4.

E.g.: If you want to enter a picture of NGC 3227, then first click New, then enter ‘NGC 3227’ in the white Set Object field and push the Set Object button. Now you can see that the object NGC 3227 is selected.
Below the Objectname you can find the Picturename. CCD-Guide suggests ‘NGC3227’ for the picture name. You can rename the picture name. (E.g. ‘NGC3227-1’ to indicate that this is the first image, which you have captured of NGC 3227).

The next step is to choose the image. Click Load Image (top right corner) to set the ‘From path’. After you have selected the image, you can see that the ‘To path’ is filled. The image will be copied from the ‘From path’ to the ‘To path’, when you click Save. But do not click Save now. First, we have to enter the other fields.

You can find a detailed description of the data fields in chapter 3.2. The following screen shot shows an example for input data.

The last step is to input observers, additional objects and additional pictures. You have to use the double arrows to the right of the observer table to add or to remove an observer.

With a mouse click on the top double arrow you can add an observer. To remove an observer, first select the observer in the table and then click on the bottom double arrow.

If you want to add an additional object, then first enter the object in the Additional Objects data field, and then press return or click on the top double arrow (to the right of the table).
To remove an additional object, first select the object in the table and then click on the bottom double arrow.

Additional pictures are pictures which show additional information (e.g. object identification, inverted image, ...). To add an additional picture, click on the Load Image button and select the desired additional image. After you have selected the image, you will see that the ‘From path’ and the ‘To field’ are filled.

Now, you have to modify the ‘To name’. You can enter any image name, but it is a good idea to use the suggested image name as base and to add some characters to indicate the type of the additional image.

If you add an additional image, which shows some object identifications then include the string ‘_id’ in the image name (e.g. NGC3227-1_id.jpg).
If you add an additional image, which shows the image in inverted mode, then include the string ‘_inv’ in the image name (e.g. NGC3227-1_inv.jpg).
After you have entered the desired name for the additional picture, you should click on the top double arrow to include the additional picture in the table.

You can add as many additional pictures as you like. The additional pictures are copied from the ‘from path’ to the User image path and renamed with the ‘To name’, when you click Save.
Now, you can click Save to save the data row and to copy and rename all pictures.

9.3. Create a new picture with Clone button

The ‘Clone method’ is a very fast approach to create a new picture data row. The idea is to select a picture data row which is very similar to the picture data row which you want to create.
So, you only have to modify the existing data fields, but you do not have to input all data starting with empty fields.

Use the Objectname Filter, the Quick Filter or the Set Filter button to find an appropriate picture data row for cloning.

Activate a picture data row in the table (indicated by blue colour) and then click Clone. Now, all data fields except object names and the picture names are filled with default data.

The further procedure is very similar to the 'New method':

- Set the object name using the Set Object button
- Edit the picture name
- Select the image using the Load Image button
- Edit all other data fields
- Observers, additional objects and additional pictures are input in the same way as described with the 'New method'.
- Click Save to save the data row and to copy and rename the pictures.
10. OBJECTTRACKER

10.1. Introduction

ObjectTracker answers quickly and easily the question whether a certain object at a selected location can be photographed in a certain night. The ideal time window for taking photographs is calculated taking into account twilight, moon, object altitude and optional horizon. The altitude progression of the object and of the moon is displayed in an intuitive graphic.

ObjectTracker can be started from CCD-Guide (via the '>>>' button) or alternatively as a stand-alone tool. To start as a stand-alone tool, double-click on the file ObjectTracker.exe in the subdirectory 'objecttracker' of CCD-Guide.

In the following, the use as a stand-alone tool is described first and afterwards practical use cases in interaction with CCD-Guide are explained.

10.2. ObjectTracker Main Window

After starting ObjectTracker the following main window appears.

The main window is divided into four areas:

- **Graphics area**: The graphics area is located at the top. For a selected night, twilight, the altitude of the object and of the moon and an optional horizon are displayed here. Red triangles indicate the beginning and the end of the object's visibility window.
- **Input area**: The input area is located at the bottom left and comprises the two areas with the headings “Deep Sky Object” and “Date, Time and Location”. Here you can select a specific object and set the desired location and date.
- **Object visibility area**: The object visibility area with the heading “Object Time Window” is located to the right of the input area. Constraints of the visibility window such as object altitude, sun altitude, moon influence or horizon consideration can be set here.
- **Info area**: The info area is located at the bottom right. Various detailed information is displayed here in a scrollable list.

Pressing the Set button (at the very bottom of the ObjectTracker window) always triggers a complete recalculation of all values and graphics.

### 10.3. Location input

The first step for using ObjectTracker is to enter the desired location. CCD-Guide is delivered with a single location: Gahberg Observatory. If you are not observing at Gahberg Observatory, you should first enter your observation location. Any number of observation locations can be created so that all users who like to make astro-journeys or have access to remote locations can quickly switch between different locations.

To create a new location, click on the Edit button in the "Date, Time and Location" area of the ObjectTracker main window. A new window opens, in which the locations are administered. In this window only one line with the location "Gahberg Observatory" is visible at the initial start.

As soon as you click on the Add button, a new line is inserted for the new location. In this new line you enter a meaningful name for the location (e.g. "La Palma"). The geographical coordinates can be set by directly entering latitude and longitude in the Latitude and Longitude fields. Alternatively, the entry can also be made via a so-called GeoHash code, if GeoHash is known for the new location. Next, enter the sea level in meters in the LevelOverSea field. It is important to choose the right time zone. The “GMT Standard Time” time zone is selected for La Palma. With this selection the values of TZone, DSTOffset and DaylightName are automatically filled correctly. If you also want to create a horizon for the newly created location, then click on the Edit button inside the Horizon frame. You can also enter a horizon for a specific location later. The creation of horizons is described below. In this way, all desired locations can now be created. To save the locations in the file Locations.csv, click on File -> Save. With Exit you can leave the location manager. The following screenshot shows the state after creating the new location "La Palma" without using a horizon.
To enter a horizon, first select the location in the location manager (The data row with an arrow in the first column is always the selected location.). By clicking on the Edit button inside the Horizon frame a new window opens, with which the horizon for the selected location can be edited. In the following example the horizon for the location "La Palma" is created.

With the pressed left mouse button a horizon can now be "painted". The following example shows an approx. 60° high obstacle on the eastern horizon and an approx. 30° high obstacle on the western horizon.
With File -> Save the horizon file can be saved. As an alternative to the graphical horizon editor, a horizon file can also be created manually by entering exact value pairs for azimuth and altitude in an ASCII file. Details can be found in the manual ObjectTracker.pdf, which is located in the CCD-Guide subdirectory `objecttracker`.

The creation of the locations is usually a one-time process. With the daily use of ObjectTracker it is usually not necessary to call the location manager.

10.4. **Selection of location and date**

When all required locations have already been created, switching between different locations is a very simple process. In the "Date, Time and Location" area, select the desired location in the Location drop-down field and all values of the location (geographical coordinates and time zone) are immediately set correctly.

**Attention:** The correct setting of daylight saving time / winter time lies in the responsibility of the user. This means that after changing the location selection, always check whether the "Daylight Saving Time" checkbox is selected correctly. As soon as the check mark is activated, this means that daylight saving time is valid. If the check mark is deactivated, ObjectTracker interprets all times as winter time.
When you open ObjectTracker, the date is set to today's date by default. If you want to make the observation planning for another date, then this is done by changing the date field. To complete the entry the return key should be pressed or alternatively the Set button should be pushed for forcing a recalculation of all fields and graphics.

10.5. Deep Sky Object Area

To select an object, enter the object name (e.g. "M 16") in the Name field. The entry of the object name should either be completed with a return or the Find button should be pressed. This triggers an object search:

- ObjectTracker first searches the local catalogs in the subdirectory \cat\ for the object. If the object is found in a local catalog, the coordinates Ra and Dec are taken from the local catalog file.
- If the object is not found, another search for the object is performed on the internet, provided an internet connection is available. If the internet search is successful, the coordinates are taken over. If the search is unsuccessful, the message "Object not found" appears.
With the Add button exotic objects can be saved in the catalog user.cat. Details can be found in the manual ObjectTracker.pdf, which is located in the CCD-Guide subdirectory \objecttracker\. The Current Objects button is described in Chapter 10.10.

### 10.6. Object Visibility Settings

After the location, the date and the object have been selected, the constraints for the calculation of the visibility time window can optionally be changed.

The Object Altitude Limit specifies the minimum object altitude required for the object to be photographed. The standard altitude is 40°.

The Sun Altitude Limit indicates the altitude below which the sun must fall for the object to be observed. The default value is -18°, which corresponds to the criterion for astronomical twilight. In the case of narrow-band photography or in the case of a light-polluted location, a larger limit (e.g. -16°) can make sense.

The Moon Illumination Limit indicates the maximum illuminated part of the moon at which an observation of the object is still possible while the moon is above horizon. If the moon is brighter than the moon illumination limit, an observation of the object is only allowed after moonset or before moonrise. The standard value of 30% can be set much higher at a light-polluted location or in narrow-band photography.

The Horizon Limit checkbox indicates whether the horizon should be considered in the calculation of the object visibility window.
10.7. Graphic area

After all settings have been made, the resulting graphic can be viewed and interpreted. We will look at the following example.

The object M 16 is to be photographed during the night of August 3 to 4, 2018 in La Palma. A horizon progression has been entered for La Palma and the default limits are used for the constraints.

In the graphic, the time from 21:00 in the evening to 8:00 in the morning is shown on the x-axis and the y-axis shows the altitude in degrees.

Twilight is indicated by the background colour of the graphic. Only in the area of the deep blue background the sun has fallen below the Sun Altitude Limit and it is astronomically dark.

Three altitude curves are shown:
- Object altitude (red)
- Moon altitude (yellow)
- Horizon (turquoise)

The dashed red line, which is drawn horizontally at an altitude of 40°, represents the Object Altitude Limit.

The two red triangles indicate the beginning and the end of the object visibility window. M16 can be photographed starting with end of dusk at 22:29. At 23:42 M16 culminates in the south (letter "S" above the red curve). At 01:13 the visibility window ends because at this time the 58%
illuminated moon rises. If the moon illumination limit were increased to 60%, the moon would be allowed to stand in the sky at the same time as the object. This would shift the end of the visibility window to 01:30. (At this time point the altitude of M16 falls below the object altitude limit of 40°).

In the above example, the observation window is not affected by the turquoise horizon.

The cursor function is particularly useful. If you move the mouse over the graphic area, a green crosshair appears at the position of the mouse. The following information is displayed in the bottom line of the ObjectTracker window: Time, azimuth and altitude of the crosshair position.

10.8. Info Area

The info area contains additional information. Especially useful is for example the distance between moon and object. In the considered example, the Moon M 16 distance is 117°.

10.9. ObjectTracker Call in CCD-Guide

ObjectTracker can be called up in the Browser tab and in the Planner tab of CCD-Guide via the ">>>" button.
The ObjectTracker object is always set to the object currently active in CCD-Guide. This allows you to quickly get an overview of the visibility conditions of the active object in the planning list of CCD-Guide.

10.10. Export OT

If the CCD-Guide-Planner contains a large number of objects, it makes sense to use the "Export OT" function in the Planner tab, because this allows you to transfer not only a single object but a list of objects of any length to ObjectTracker. A realistic use case looks like this:

First, in the "Planner" tab, the list of objects is reduced to a reasonable number with the help of Set Filter. For example, the RA range could be roughly restricted so that the objects are certainly visible at some time point in the selected night. Further criteria such as object type etc. could be set to make the list even smaller.

The filtered object list of the Planner can then be exported to the ObjectTracker catalog file CCD_Guide.cat, which is located in the subdirectory \objecttracker\cat, by clicking the Export OT button. An already existing file CCD_Guide.cat is always overwritten.

Next, switch to the ObjectTracker. With the help of the window "Current Objects" you have access to all catalogs in the \cat\ folder. Details about the "Current Objects" window can be found in the manual ObjectTracker.pdf, which is located in the CCD-Guide subdirectory \objecttracker\.
CCD-Guide automatically makes meaningful settings in the Current Objects window as soon as Export OT is started. These settings are:

1. Select only the catalog CCD_Guide.cat in the ObjectTracker catalog list.
2. Deactivate the check mark "Filter". This makes all objects in the CCD_Guide.cat catalog visible in the table on the right. The table now shows the same objects as the filtered table in the planner.

As soon as you click into an object line of the current objects list, this object is set in the ObjectTracker main window. You can now use the arrow keys on the keyboard to quickly move from one object line to the next object line. The ObjectTracker main window is automatically updated with each object change. This allows you to quickly and easily find the most suitable object for observing.

<table>
<thead>
<tr>
<th>Select</th>
<th>Catalog</th>
<th>Object</th>
<th>RightAscension</th>
<th>Declination</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Caldwell</td>
<td>BARNARD 147</td>
<td>20 06 50</td>
<td>35 22 00</td>
</tr>
<tr>
<td></td>
<td>CCD_Guide</td>
<td>BARNARD 340</td>
<td>19 48 44</td>
<td>11 24 00</td>
</tr>
<tr>
<td></td>
<td>HH</td>
<td>IC 1318</td>
<td>20 22 14</td>
<td>40 15 24</td>
</tr>
<tr>
<td></td>
<td>IC</td>
<td>LBN 111</td>
<td>20 12 47</td>
<td>01 16 00</td>
</tr>
<tr>
<td></td>
<td>LDN</td>
<td>LBN 132</td>
<td>20 25 20</td>
<td>14 09 48</td>
</tr>
<tr>
<td></td>
<td>MESSIER</td>
<td>LBN 248</td>
<td>20 20 28</td>
<td>41 21 00</td>
</tr>
<tr>
<td></td>
<td>NGC</td>
<td>LDN 657</td>
<td>19 21 18</td>
<td>08 53 42</td>
</tr>
<tr>
<td></td>
<td>User</td>
<td>M 31</td>
<td>00 42 44</td>
<td>41 16 08</td>
</tr>
<tr>
<td></td>
<td></td>
<td>M 45</td>
<td>03 47 24</td>
<td>24 07 00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NGC 2024</td>
<td>05 41 42</td>
<td>01 51 24</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NGC 6749</td>
<td>19 05 15</td>
<td>01 54 05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NGC 6934</td>
<td>20 34 12</td>
<td>07 24 17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NGC 918</td>
<td>02 25 51</td>
<td>18 29 45</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SH2- 88</td>
<td>19 45 59</td>
<td>25 20 00</td>
</tr>
</tbody>
</table>
11. APPENDIX A – THE DATA MODEL

CCD-Guide is working with two databases:

- **master.mdb**: This database can be found in the database path (default path = subfolder “database” of the CCD-Guide installation). The master.mdb is write-protected and contains the object data, the setup data and all picture data of pictures of AAS members, which can be found on the DVD. The master.mdb is updated every year by AAS.

- **user.mdb**: This database can be found in the user data path (default path = subfolder “userdata” of the CCD-Guide installation). The user.mdb contains your own data (object data, setup data, picture data and planner data). It is empty, when you start with your own inputs. CCD-Guide joins the two databases user.mdb and master.mdb with UNION JOIN.

If you want to know more about the data model, then you can open user.mdb with MS Access. Please, do not modify the data using MS Access!
12. APPENDIX B – WHAT’S NEW IN RELEASE 3.4

- **ObjectTracker:** CCD-Guide is delivered with the new and very powerful planning tool ObjectTracker, which was developed by Hartmut Bornemann. ObjectTracker can also be used as a stand-alone tool. It quickly and easily answers the question of whether a particular object can be photographed at a selected location on a particular night. The ideal time window for taking photographs is calculated taking into account twilight, moon, object altitude and optional horizon. The altitude progression of the object and of the moon is displayed in an intuitive graphic.

- **Extended ‘>>>’ functionality:** In CCD-Guide 3.4 the '>>>' button was extended by the ObjectTracker function. This means that ObjectTracker can be started with one click with the currently active object of the browser or of the planner.

- **Export OT:** The filtered object list of the Planner can be exported to the ObjectTracker catalog file CCD_Guide.cat. Thus not only a single object can be transferred to ObjectTracker from CCD-Guide but a list of objects of any length. This is very useful when selecting the best object to shoot from a large number of possible objects.
13. APPENDIX C – WHAT’S NEW IN RELEASE 3.3

- **1 bug fixed**
- **Simplified folder structure:** The new folder structure is based on a clear separation between master data (= all data and all images which are delivered with CCD-Guide) and user data (= all inputs and all images of the user). This separation simplifies the process of creating a backup of your own data, makes an update to future releases of CCD-Guide easier, and offers a convenient possibility to switch between different user databases.
- **Extended ‘>>>’ functionality:** CCD-Guide 3.3 offers the possibility to use the ‘>>>’ functions (Planetarium, Sky-map.org and Export to Planner) also in cases when you have set an Objectname filter, but no datasets were found.
14. APPENDIX D – WHAT’S NEW IN RELEASE 3.2

- **3 bugs fixed**
- **ListView for Browser improved:** The procedure to change the appearance of the main data table in the tab Browser was significantly improved. It is now very easy to make columns visible or invisible, to change the order and the width of columns and to save all settings.
- **ListView in tabs Planner, EditObject and EditPicture:** The new ListView features for configuring the layout of the main data table are now also available in the Planner tab, in the EditObject tab and in the EditPicture tab.
- **QuickFilter:** Previous releases of CCD-Guide offered two possibilities to filter a main data table: the ObjectnameFilter and the SetFilter. Additional to these two filter types a new type is now introduced, the so called QuickFilter. When you enter a search string into the edit field of the QuickFilter, then only those data rows are shown which contain this search string in one of the data fields. This is a very fast and efficient way to reduce the number of data rows in a main data table. QuickFilter is available in the tabs Browser, Planner, EditObject and EditPicture.
- **Improved performance of ObjectBrowser:** Switching between ImageBrowser and ObjectBrowser is now much faster than in the previous release.
- **Improved performance of SlideShow in Planner**
- **Export CSV:** The main data tables of the tabs Planner, EditObject and EditPicture can be exported into a csv-file.
- **Simplified button structure in Browser and Planner**
- **New default name for REF images in Planner**
15. **APPENDIX E – WHAT’S NEW IN RELEASE 3.1**

- **10 bugs fixed**
- **Night vision mode:** The Help tab and the About tab were improved to give better results when using a software which enables a night vision mode (e.g. software The Sky).
- **Sorting of tables:** Improved sorting of tables according to object name.
- **Edit Picture:** Edit Picture is easier to use because of removing the extension jpg in picture name.
- **New catalogues:** Sandqvist and DCLD.
- **Working with an external hard disk:** Working with CCD-Guide on two different computers using the same external hard disk is now easier, because the paths are automatically set.
16. APPENDIX F – WHAT’S NEW IN RELEASE 3.0

- **Set Filter in all tabs:** Advanced filter options are now available in all tabs. This was possible by moving the old Set Filter tab into a new window, which can be called in all tabs of CCD-Guide.

- **ObjectBrowser:** The ImageBrowser tab was renamed to Browser tab. The Browser tab contains now two different modes: the ImageBrowser mode and the ObjectBrowser mode. The ImageBrowser feature was already available in Release 2.0, but the ObjectBrowser mode is completely new. The ObjectBrowser opens the possibility to browse through the object data of all objects of the CCD-Guide database including the usage of the advanced filter options of the Set Filter window.

- **Planner:** The Planner tab was completely reworked and is now much easier to use. The creation of setups was moved to Edit Setup tab. The free space in Planner tab was used to show a bigger preview image of the planner image. The data grid of the Planner tab can show all planner data rows of all of your setups in one table and you can filter your planner data rows with new filter options.

- **New Set Filter features:** The Set Filter window has a new type of filter criteria, the so-called ‘Planner Criteria’. With these criteria you can easily filter your planner data rows. You can save and reload your filter settings. This is very useful, if you create many complex and powerful filters.

- **New planetarium programs:** In Release 2.1 you could open Cartes du Ciel, centred on an object which was selected in the ImageBrowser. Release 3.0 gives you the possibility to choose between the following planetarium programs: Cartes du Ciel, Guide 8, Guide 9, The Sky6 Pro and The SkyX Pro. The planetarium button is now not only available in the ImageBrowser but also in the ObjectBrowser and in the Planner.

- **Link to sky-map.org:** When you are connected to the internet then you can use the new sky-map.org button, which opens sky-map.org, centred on the selected object in ImageBrowser, ObjectBrowser or Planner.

- **FOV Image in Planner:** When you are connected to the internet then you can use the new FOV Image button to download an image from sky-map.org with the right image field of your selected setup.

- **Export to Planner:** The active object in ImageBrowser or in ObjectBrowser can be easily exported to the Planner.

- **Order of tabs:** The order of tabs was changed, so that the most important tabs come first. The new tab sequence is: 1. Browser (ImageBrowser + ObjectBrowser); 2. Planner; 3. Edit Setup; 4. Edit Object; 5. Edit Picture; 6. Options.

- **Find Object:** Find Object is now easier to use. It is not necessary to enter a blank character between the catalogue name and the catalogue number. (e.g: ‘ngc 1’ and ‘ngc1’ are allowed).

- **Sorting in data grids:** By clicking on the head of data columns you can sort the data grid. This feature is now available in all tabs.

- **Import new comets:** When you are connected to the internet, then you can import new comets into your object database from www.minorplanetcenter.net.

- **Filter status is indicated:** When a filter is active on a data grid, then the active filter is indicated by bold characters of the Set Filter button. When a Find Object filter is active, then this active filter is indicated by bold characters of the Find Object button.